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1.0 DataHost Overview

DataHost is the end-user software application for the DataNet wireless data network. It is designed to
run on a eosnecting ® th® [MataGate server over a LAN or Internet connection. When
connected to the server, DataHost can communicate with remote assets - decoding their positions,
sending and receiving messages, and configuring asset settings. DataHost also has an interface to
several mapping programs, providing real-time vehicle tracking and history replays.

The DataGate server is normally configured to buffer all data from remote assets if a DataHost is
offline for any reason. This means that you will not lose any data if you turn your PC off, or your
Internet link drops. The next time you start your DataHost, the buffered information will be forwarded
to you automatically.

© 2000 -2007 Datalink Systems, Inc. www.datalinksystemsinc.com
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2.0 Installation
2.1 System Requirements

PC with a Pentium-class processor or higher

Microsoft Windows 98/ME/2000/XP/Vista/7 operating system (with latest service packs)
At least 64 MB of RAM recommended

CD-ROM drive if installing from CD

10 MB hard-disk space for program files

Additional hard-disk space required for mapping programs and history data

1024x768 16-bit colour display or higher recommended

Sound card recommended

= =4 _—_a_-8_-9_-48_-93_-°

2.2 Software Installation

DataHost may be provided on a CD, or as a zipped setup file. If installing from a CD, insert the disc
into your PC, and select the Install DataHost option from the CD menu. If the menu does not start
automatically, use Windows Explorer to navigate to the CD drive and run the \autorun\autorun.exe
file. To install from a setup file, simply unzip the file contents to a temporary directory, and run the
setup.exe file.

Note that DataHost is released in separate packages for different MapPoint versions. If you
are going to use MapPoint maps with DataHost, make sure you install the release that
matches your version of maps. Currently, two versions are supported: MapPoint 2002 and
2004.

From time to time updates are available for DataHost. These are placed on our downloads web page
(see http://www.datalinksystemsinc.com/download.html).

Note: When updating DataHost to a newer version, it is recommended to simply replace the
datahost.exe file in the program directory. To do this, first close DataHost if it is running, and then
copy the new file over the existing one. Exe file updates are provided on our website, as well as the
full install version for new PCs. If you decide to use the full install option on a PC already running
DataHost, it is recommended to uninstall the previous version first (using Add/Remove Programs
from the Windows Control Panel). Data and history files will not be erased during this process.

© 2000 -2007 Datalink Systems, Inc. www.datalinksystemsinc.com
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When the setup process starts, it will copy the required installation files to disk (see Figure 1).

Copying Files, please stand by.

Figure 171 Installation program

The set-up program will then display a reminder to close down any applications that may be running
(see Figure 2). This allows the program to update files that may otherwise beinus e. Cl i ck @AO
continue the installation.

s= DataHost 3.0.9 (for Mappoint 2002) Setup

Welcome to the DataHost 3.0.9 (for Mappoint 2002) installation
program.

Setup cannot install system files or update shared files if they are in use,
Before proceeding, we recommend that you dose any applications you may
be running.

Exit Setup

Figure 27 Installation part 2

© 2000 -2007 Datalink Systems, Inc. www.datalinksystemsinc.com
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Figure 3 shows the next set-up screen, which prompts the user to enter the installation directory. The

default directory is recommended. Click the computer icon to continue.

“= DataHost 3.0.9 (for Mappoint 2002) Setup

Beqgin the installation by dicking the button below.

Click this button to install DataHost 3.0.9 (for Mappoint 2002) software to
the spedfied destination directory,
ey
Directory:
C:\Program Files\DataHost), Change Directory

Exit Setup

Figure 371 Installation part 3

The final choice in the set-up process is to select a program group. This is the location where a
shortcut to DataHost will be placed, accessible through the Windows Start menu. The default setting
is recommended. Click AContinueo to begin instal

42 DataHost 3.0.9 (for Mappoint 2002) - Choose Pr... [X]

Setup will add items to the group shown in the Program Group box.
You can enter a new group name or select one from the Existing
Groups list,

Program Group:

Existing Groups:

AcCcessories A
Administrative Tools 3
DataMet
HTML Help Workshop

L%

Continue | Cancel

Figure 41 Installation part 4

© 2000 -2007 Datalink Systems, Inc.
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You may be prompted to restart your computer if the set-up program detects out-of-date files. In this
case, restart the PC and restart the setup process to complete the installation.

The installation may be cancelled at any step. In this case the program will remove temporary
DataHost set-up files from the hard disk.

2.3 Initial Settings

When the set-up program completes, there will be a shortcut to DataHost in the Windows Start menu
under fAStart/ Programs/ DataNeto (assuming theupdef
process). Select this shortcut to start DataHost.

The first time DataHost is loaded, it will prompt the user for initial set-up information. These settings
are required for the DataHost to connect to the server, through which all data communications take
place. Figure 5 shows the initial screen.

<" DataHost Initial Set-Up =

Server Name or IP Address

Password

I

Contact your Server provider to obtain a
password

| oK | Exit

Figure 57 Initial settings

Select the appropriate server address and password to continue. These options will be supplied to
you by the server operator.

When first run, DataHost creates several data files in its program directory (see section 11.0 for a list
of the data and log files used). The data storage directory can be changed under the Options menu.

2.4 Mapping

If mapping is required, the map program may need to be installed separately. DataHost currently
supports Microsoft MapPoint, Virtual Earth, Streets on a Disk, ArcView Tracking Analyst, and Google
Earth. Maps are configured through the View/Options menu (see section 10.3).

© 2000 -2007 Datalink Systems, Inc. www.datalinksystemsinc.com
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3.0 Screen Layout

Figure 6 shows the main DataHost window. The title and icon of the application show the current
DataHost status. At the top of the window is a toolbar, which provides access to the most frequently
used DataHost functions. Directly underneath this is a message status bar, which provides a quick
way to access new messages. Three list boxes provide details about the assets being tracked. The
Assets list shows the complete list of assets this DataHost has access to. The Properties and
Messages lists contain details about the currently selected asset. At the bottom of the window is a log
list box showing recent data communications. If MapPoint or Virtual Earth maps are enabled, a map
will be shown on the right side of the window. Each part of the window can be resized by dragging
the list/map borders. Along the bottom edge of the window is a status bar, showing the data storage
location and current connection state.

%= DataHost - 1 New Message Q@@
File View Map Asset Help

S L ' @ Q ® a @

Poll Configure Reports GoTo Follow Geofence Zoom Out Zoom In

1 New Message Show First New Msg Show All

Assets l Mt':ssages - Florida Demo S Mapl’%"i‘ﬁ‘i‘
@ Florida Demo (0.0.2) « Seftings Request  1/11/2006 8:51:10 p.m.
JANZ Demo (0.0.3) « Poll 201172006 £:00:19pm. | . | G e S~ | faat) [T
© Palm Springs Demo (5.0.2) @ Input 1 = Low 21/03/2007 2:46:45 p.m. " The Everglades 1%
@ vk Demo 7.7.7) Coral Springs

Vi \ (255.255.250)
ldgo ancouver Demo (255.255.250) Everglades Wildlife

Management Area :
Horth Layiderdale”

Properties - Florida Deme ]

Last Transmission: 21/03/2007 2:456:45 p.m.
Network: GPRS/CDMA

Last Position: 11/04/2007 1:55:01 p.m.
GPS Time: 11/04/2007 1:54:57 p.m.
GPS Signal: Valid

Speed: 27 km/h

Heading: S

Latitude: 26.13718°

Longitude: -80.21373°

Location: 41 km N of Miami, Fla.

Input 1: (Low)

Input 2: (Low)

Input 3: (High)

Input 4: (Low) < >
2007/04/11 14:07:54 Updating map... ~
2007/04/11 14:07:54 Creating map dataset (Assets)

2007/04/11 14:07:55 Map updated OK v
Using file directory c:\logs\datahost\ |

Figure 6 1 Main DataHost window

3.1 Application Title/Icon

DataHost will change its application title and icon (shown at the top left of the window, and in the
Windows taskbar) depending on its connection and message status. The title changes to indicate if
there are any new messages, and the icon changes as follows:

* DataHost is online with no new messages

& DataHost is online with one or more new messages

® DataHost is online with one or more high priority messages
® DataHost is offline

© 2000 -2007 Datalink Systems, Inc. www.datalinksystemsinc.com
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When DataHost is offline, the log window will turn red to warn the user.

3.2 Toolbar

The toolbar provides quick access to several functions. These functions are also accessible through
the Map and Asset menus, or by right clicking on the asset list (or map). The following functions are
available, depending on the device type and configuration:

& send Msg Send a message to the asset (see section 6.3).
& Poll Request the current position of the asset.
£ Configure Open the asset configuration window, for remotely sending and retrieving
device settings (see section 5.5).
% Outputs Control asset outputs (see section 5.5).
Ed Reports Create reports about this asset from history data (see section 7.0).
* Geofence Monitor t he aadshdw@sale ibitsmoves acartain distance
(see section 5.7).
# Track Show the assetods distance and heading

The following options will only be available when supported by the currently selected map:

@ Go To Centre the asset on the map. Note that the zoom level of the map will not be
changed when this function is selected. To zoom in or out, use the zoom
functions.
Follow When following, the map will move to keep the asset on screen. To stop
folowing, simply c¢click the AFol |l owR6).butto
€. Zoom Out Shows a larger area of the map.
% Zoom In Shows a smaller area of the map.

3.3 Message Status Bar

The message status bar is located directly under the toolbar. Normally this bar will be a dark grey
colour, and will show ANo New Messageso. I f a ne
yellow colour as shown, and indicate the number of unread messages. If a high priority message is
received, the bar will turn red (see section 6.8). This bar will remain coloured until all new messages

have been read (opened). When new messages are available, the bar provides shortcuts to open the

first new message (oldest unopened message), or to show all messages (also available from the
View/Communications menu).

3.4 Assets List

Use the Assets list box to select an asset. When an asset is selected, both the Properties and
Messages lists will be updated for that asset. See section 5.1 for more information.

3.5 Properties List

The Properties list shows the most recent information received from the selected asset. The fields
displayed depend on device type and configuration. See section 5.2 for more information.

© 2000 -2007 Datalink Systems, Inc. www.datalinksystemsinc.com
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3.6 Messages List

The Messages list box shows any messages and/or packets sent or received for the selected asset.
See section 6.1 for more information.

3.7 Map Display

If maps have been enabled, each asset is shown on the map, unless it has been hidden (see section
5.1) or does not have a valid position. MapPoint and Virtual Earth maps are built-in to the DataHost
window, while other maps run as separate applications. See section 7.0 for more details.

Because MapPoint and Virtual Earth maps are embedded into the DataHost program, the maps are
more interactive, as follows:

Selecting an asset on the map will automatically select it on the Assets list (and therefore the

Properties and Messages lists). Right clicking on the map brings up the map menu (also accessible

from the main menu). This menu provides shortcuts to common map functions and display

adjustments. The maps use the same icons as shown in the assets list. To zoom in or out on the

map, use the AZoom Ind and AZoom Outo buttons on

3.8 Log List

The data communications log shows all data transmitted to and received from assets, as well as
other information such as connection messages. When the program is started, it will attempt to
connect to the DataGate server (as set-up in the Options window). If no connection can be made, it
will retry periodically. In this case, check that the server is running, the IP address and ports are

correct,andthe correct password is being used. Once a c
message will be given, and the host will be sent a list of all the assets it has access to, along with

their descriptions and most recent data. If an updated DataHost programisavai | abl e, an @A U
Avail abled message may be shown. | f the DataHost

may be a lot of data buffered by the server. This data will appear in the log box, and may take several
seconds or minutes to download.

© 2000 -2007 Datalink Systems, Inc. www.datalinksystemsinc.com
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If the connection to the server is lost for any reason, the log list will turn a red colour (see Figure 7). If
the connection is lost for more than a minute, a warning window will be displayed and the DataHost
will beep until this window is closed or the connection is re-established.

DataHost - No New Messages

Map fAsset Help

/s @ | 2 % @ | @ & # #u | & @
SendMsg  Poll Configure COutputs  Reports | GoTo Follow Geofence Track | Zoom Out Zoom In
No New Messages
Assets I Messages - Palm Springs Demo | B 3
O Florida Demo (0.0.2) £30n my way 8/12/2006 11:37:27 a.m.
O NZ Deme (0.0.3) £33 Overspeed Warning'...  1/03/2007 8:24:18 a.m.
O Palm Springs Deme (5.0.2) Z) HEADING TO JENSENS  18/03/2007 8:26:57 a.m.
O UK Demo (7.7.7) £2) ARRIVED AT JENSENS  18/03/2007 8:30:10 a.m.
O Vancouver Deme (255.255.250) £2) LEAVING JENSENS 18/03/2007 8:45:37 a.m.
£33 Hello 18/03/2007 4:28:32 p.m. nipe
Properties - Palm Springs Demo SQNa fh o
2 B UnSeE
Last Transmission: 20/03/2007 10:49:18 a. A\ DataHost Warning e
Network: GPRS/CDMA. - [
Last Position: 20/03/2007 10:48:26 a.m. Could not connect to Server. Check Internet connection W

GPS Time: 20/03/2007 10:48:23 a.m.
GPS Signal: Invalid {old data)

Speed: 0 km/h (old data)

Heading: N (old data)

Latitude: 33.80107°

Longitude: -116.50922°

Location: 137 km NE of San Diego, Calif.

Select "Work Offline” to disable connection attempts. Note that no live data will be received when in
offline mode. Working offline can also be enabled and disabled using the option on the File menu.

i
e

Work Offine |

g

Figure 71 Losing the DataGate connection

3.9 Status Bar

The status bar is located at the bottom of the DataHost window. The current data storage folder is
listed on the left side of the bar. On the right side is an icon, which shows the current communication
state as follows:

sl Not connected to the DataGate server.
+ Connected and idle.
hid Receiving data from the server.

© 2000 -2007 Datalink Systems, Inc. www.datalinksystemsinc.com
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4.0 Main Menu
4.1 File Menu
Work Offline: Select this option to disconnect DataHost from the server, and disable
connection attempts. Deselect option to restart connection attempts.
Exit: Exit program.
4.2 View Menu
Reports: Starts the Reports wizard (see section 7.0).
Communications: Shows the Communications window (see section 6.7), which allows you
to see all messages sent and received.
Locations: Shows the Locations window (see section 9.0), where you can edit user

defined locations.

Open Today 6Q@pens thgDataHost log file created today. The log keeps a copy of data
shown in the DataHost log box.

Options: Access DataHost options.

4.3 Map Menu

The map menu is only visible when MapPoint and Virtual Earth maps are enabled. It may also be
accessed by right clicking on the map itself. The following mapping functions are provided:

Zoom to All: Zoom in or out to display all assets on the map.

Zoom In: Zoom in at the current map location.

Zoom Out: Zoom out at the current map location.

Full Screen: Show the map in full screen mode. Select this option again to
disable.

Save: Saves current map, so it will appear next time DataHost starts.

MapPoint Menu Functions:

Previous View: Returns map to the previous view (after moving or zooming).

Switch Map Style: Changes map display style (data, road, terrain, etc).

View as Globe: When zoomed out to a global level, the map can display as a globe
or flat map.

Show Toolbar: Show or hide the MapPoint toolbar.

Show Legend: The legend shows user data sets, allowing the deletion of user
reports.

Show Location Reading: The latitude and longitude at mouse pointer is shown above map.

Clear Report Data: Clears any history data from map.

Export: Exports current map to a temporary file, for editing using MapPoint.

Print: Prints current map to default printer.

Set Quadrant Area: Sets overall view for automatic quadrant feature.

Automatic Quadrant View: Map will automatically switch between an overall view, and four
Acl-ape0o centred on eachvieguadr ant

© 2000 -2007 Datalink Systems, Inc. www.datalinksystemsinc.com
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Virtual Earth Menu Functions:

Reload: Reloads the map.
Clear Find Results: Clears any search results from map.

4.4 Asset Menu

This menu contains asset specific commands for the currently selected asset. It may also be
accessed by right clicking on an asset in the asset list.

Add Group: Adds a user definable group of assets. Groups make it easier to poll or
send messages to several assets at once.
Send Message: Send a message to an asset (if available). Depending on asset type,
different kinds of messages or trips can be sent.
Poll: Request the assetds current | ocati ol
Configure: Opens the Asset Configuration window to retrieve or modify asset
settings.
Set Outputs: Control the assetb6és outputs (i f aval
Reports: Opens the Reports wizard for this asset.
Go To: Moves the map to this location.
Follow: Map will follow this asset.
Geofence: Alerts user if asset moves from current location.
Track: Moni tor assetdos distance from a pre:
Properties: Opens the asset properties window (see section 5.1)
4.5 Help Menu

The Help menu provides a link to the DataHost About screen, which shows the software version

number.
s About DataHost @

DataHost Verzion 3.0 Build 10
Datalet Client Interface

Copyright ® 2000-2007 Datalink Systems, Inc.

web: hitp:hwww datalinkzystemszinc.com
email. support@datalinkzyetemzine. com

Figure 8 DataHost About screen

© 2000 -2007 Datalink Systems, Inc. www.datalinksystemsinc.com
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5.0 Assets
5.1 Assets List

The assets list on the main screen shows all assets this DataHost has access to. This list is
configured on the DataGate server, so contact your server operator if you need to make changes to
the 1ist. Each assetds name is also configured o

Double clicking on an asset will either centre the map on that asset (if mapping is enabled and the
asset is shown), or show the asset properties window (see section 5.1). The Assets list uses icons to
indicate the current status of each asset. Up to four icons can be shown, as follows (each in order of

priority):

First lcon (message status):

® A high priority message has been received from asset (text will be bold).
2 All messages are being hidden (see section 5.3).

b A new message has been received from asset (text will be bold).

‘g An outgoing packet could not be sent.

g Trying to send a packet to asset.

Second Icon (general asset status):

@ Asset has not yet reported a GPS position.

Q Asset has old or invalid GPS position. Data is old after a certain period, as define in
DataHost options (see section 10.7).

@ Asset is stopped, with recent position report.

3 Asset is moving, with recent position report.

& Asset Group

Third Icon (only used for assets with Alarm attachments):

i Alarm is armed (locked).
e Alarm is disarmed (unlocked).

Fourth Icon (special functions):

Following asset. Map will pan if asset moves off screen.
o+ Asset is geo-fenced. Radius will be shown in the properties list.
4 Tracking option enabled. Distance to destination will be shown in properties list.

5.2 Properties List

The Properties list on the main screen shows the most recent information received from the selected
device. It includes the following fields (actual fields displayed depend on device type and
configuration):

© 2000 -2007 Datalink Systems, Inc. www.datalinksystemsinc.com
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Driver: Currently logged-in driver, if available.
Duty Status: Driver duty status, if available.
Current Trip: Trip ID, if available.

Trip Status: Status of current trip.

Last Transmission: Time and date of last data from asset. Note that all times are converted to
local time using the PCs time zone.

Network: Network that last packet was received on.

Inputs/Outputs: Status of assetods inputs and outputs
outputs). Some assets also have battery and temperature fields.

Last Msg Sent: If asset can receive canned messages, this field shows the last message

sent to the asset.

If asset has reported a position, the following properties are included:

Last Position: Time and date when most recent position report was received.

GPS Time: Time and date last GPS report was created.

GPS Signal: Show if GPS signal is valid.

Speed: Asset speed at last report.

Heading: Heading at last report.

Latitude/Longitude: GPS coordinates at last report.

Location: Most recent distance and direction from nearest point of interest. See
section 9.0 for details on the location property.

Destination: If the Track feature is turned on for this asset, the distance and heading to
the destination location is shown.

Geofence: If Geofence is enabled, this shows the fence radius.

5.3 Asset Properties

Double click an asset on the map (MapPoint only), or right click an asset in the asset list and select
properties, to open the Asset Properties window. Figure 9 shows the asset properties window, which
shows the following information and settings:

Asset Status: Indicates when last data was received from asset.
GPS Position: Status of GPS data from asset.
Destination Location: Location used to calculate destination for Tracking feature.
Geofence Radius: Distance asset is allowed to move before alert is sent.
Message Options: Select what type of messages to hide from Messages list.
Show Asset Icon on Map: If deselected, asset will not be shown on map, and the text
AHi ddeno will appear in the asset
Highlight Icon: In MapPoint, icons can be highlighted to improve visibility.
Show Label: In MapPoint, icons can have a label showing asset description.
Only Show when Selected:Select this option to hide the icon when another asset is selected.
Set All Assets Like This: Sel ect to configure all assets wi
Request Byte Counts: Requests byte counts from server, which shows how much data

this asset has sent and received during the current and previous
months. The response to this request will be shown in the log box.
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i Properties - Vancouver Demo @

Azzet Status:

GPS Pogition: Old data

Destination Location

MNone

Mes=zage Options

[ Hide All Incoming Mezsages
v Hide Duty Status Changes
v Hide Trip State Changes

v Hide Driver Log Mez=zages
¥ Hide Waypoint Mes=zages

Map Optionz

[v Show Asset jcon on Map:
v Highlight lcon (Mappoint onby)
v Show Label (Mappoint onhy)

Request Byte Countz |

v Only Show when Selected

o]

Mo recent communication (4 hourg)

Geofence Radiug (km)

0.500

Set All Azzets Like This

Set All Azzetz Like This

Cancel

Figure 91 Asset properties

5.4 Asset Configuration

Figure 10 shows the Asset Configuration window. This screen will show different options depending

on the type of devi
settings availabl eo.
following fields are shown for each asset:

ce.

Type:

f

Sett

no
ngs

sett
can

Firmware Version: Firmware version of this device (if available).

Asset ID:

Unique ID, assigned by server.

ngs

be

have
retri

previ
eved,

Device type. May be a black-box, data terminal, laptop, etc.

© 2000 -2007 Datalink Systems, Inc.

www.datalinksystemsinc.com




DataHost Manual (3.0) Page 18

/4 Palm Springs Demo Configuration

Settings

General

Type: Laptop

General l City ] Highway] Ad'.fﬂnl:ed] E'.fentsl Net'-.'.'l:lrk]

Firmware Verzion: 2.75 AszsetD: 502

Time Zone (GMT): |0

Advanced Configuration |

Retrieve Send

Time Zone:
Sleep Timeout:
Input Debounce:
City/Highway:
Use Time:

Use Distance:
Thresholds:

Report Time:
Report Distance:

Min Report:
Heading Change:

Change Duration:

GPS Sats Required:

Figure 107 Device configuration

5.4.1 Reporting Settings

Some devices display time on their screens. This setting is used to
convert from GPS to local time.

Asset will enter sleep mode after this delay when ignition is turned off.
Debounce period for inputs.

Where available, assets can report using two sets of parameters,
based on vehicle speed.

Report position based on a time interval.

Report position based on distance travelled.

Thresholds define the speed at which to move from one set of
reporting options to another. | f
threshold, city settings are used. Likewise, if the speed rises above the
highway threshold, highway settings are used.

Time between reports.

Distance between reports. Distance reporting prevents unnecessary
reports when devices are stopped.

Minimum time between position reports. This places a limit on the
maximum reporting rate.

Asset will send a position when its heading changes by a certain
amount.

Heading change must occur for at least this period.

Number of GPS satellites used to treat position as valid. This can be
used to improve accuracy, by treating GPS positions determined with
a few satellites as invalid.
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Enable Waypoints:
Detect Overspeed:
Report Stops/Starts:

Asset will report when it enters a waypoint area.
An event can be sent when the asset exceeds a set speed.
The asset can be set to report whenever it starts and/or stops. The

Report Input Changes:

Input Triggering:
Max Speed:

Overspeed Limit:

Stopped Speed:
Stop Time:
Restart Speed:
Restart Time:
Cell Keep-alive:
RF TX delay:
RF TX tail:

RF ACK Delay:
Trunked RF:
GS Buffer Type:

GS Timeout:

Buffer Time:

times and speeds to trigger these events can be programmed to allow
for GPS drift and traffic delays.

Send events when inputs change.

Select what type of input change will trigger events.

Speed at which asset is considered to be speeding.

Driver is allowed to exceed max speed for a certain duration.

Speed under which asset is considered to be stopped.

Asset must remain stopped for this period to trigger a stop event.
Speed over which asset is considered to be moving.

Asset must remain moving for this period to trigger a start event.
Asset can send a small packet periodically to ensure its cellular IP
address is retained.

For RF modems, this is the time between triggering transmitter and
sending data. This period allows the transmitter to come up to full
power.

Time to leave transmitter on after data transmission has finished.
Time to wait before sending the reply to a request. This allows time for
the transmitter to return to receive mode.

Modem will wait for a channel acquired signal from radio before
sending data (RF modems).

Set type of packets to be buffered. Buffering improves efficiency by
allowing multiple packets to be sent at once.

Globalstar data sessions will timeout if inactive for this period. Note
that the server will also instruct the modem to go offline if it has no
more data to send.

Period to buffer data. When this period expires, a data session will be
established.
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5.4.2 Advanced Configuration

Some assets have other settings that can be controlled remotely. Figure 11 shows the advanced
configuration screen.

Figure 117 Advanced configuration

If an asset has the optional engine monitoring interface, it can monitor certain engine parameters and
send an event when an exception occurs. Each parameter has a configurable threshold, and can be
set to transmit an alert and/or warn the driver.

Waypoints are used to trigger reports based on position. Each waypoint has an ID in the range 0-
32767, a latitude and longitude, and an inner and outer radius. If the asset travels within the inner
radius, a report containing that waypoint ID is sent. Another report for that waypoint will not be sent

unt i | the device has moved outsiidet d hlkubuoert oad

waypoint IDs currently in use.

Many devices have built-in messages, which can be modified remotely. Each message has an ID in
the range 0-15. The Internal Messages frame allows each message to be retrieved, modified, and
sent back to the asset.
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